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for Peachpit Press. His books have sold more than a million copies worldwide.
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late techie jargon into usable and fun advice for regular folks. Bob is also a pro-
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MacJeopardy World Championship three times before retiring his crown.)
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In 2004, LeVitus founded his most ambitious undertaking yet, Doctor Mac
Direct LLC (www.doctormacdirect.com), a company that provides expert techni-
cal help and training to Mac users, in real time and at reasonable prices, via
telephone, e-mail, and/or its own unique Internet-enabled remote control soft-
ware. If you're having problems with your Mac, you ought to give them a try!

Prior to giving his life over to computers, LeVitus spent years at Kresser/
Craig/ D.LK. (a Los Angeles advertising agency and marketing consultancy)
and its subsidiary, L & J Research. He holds a B.S. in Marketing from
California State University.
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Introduction

ou made the right choice twice: Mac OS X Tiger and this book.

Take a deep breath and get ready to have a rollicking good time. That'’s right.
This is a computer book, but this is going to be fun. What a concept! Whether
you’re brand spanking new to the Mac or a grizzled old Mac vet, | guarantee
that discovering the ins and outs of Mac OS X Tiger will be fun and easy.
Wiley, Inc. (the publisher of this book) couldn’t say it on the cover if it
weren’t true!

About This Book

This book’s roots lie with my international bestseller Macintosh System 7.5
For Dummies, an award-winning book so good that now-deceased Mac cloner
Power Computing gave away a copy with every Mac clone they sold. Mac OS
X Tiger For Dummies is the latest revision and has been, once again, com-
pletely updated to include all the cool new features found in Mac OS X Tiger.
In other words, this edition combines all the old, familiar features of the pre-
vious books (Mac OS 7.6 For Dummies, Mac OS 8 For Dummies, Mac OS 8.5 For
Dummies, and Mac OS 9 For Dummies, plus the three previous editions of Mac
OS X For Dummies with cat names) — but once again expanded and updated
to reflect the latest and greatest offering from Apple.

Why write a For Dummies book about Tiger? Well, Tiger is a big, somewhat
complicated personal-computer operating system. So I made Mac OS X Tiger
For Dummies a not-so-big, not-very-complicated book that shows you what
Tiger is all about without boring you to tears, confusing you, or poking you
with sharp objects.

In fact, I think you’ll be so darned comfortable that | wanted the title to be
Mac OS X Tiger Without Discomfort, but the publishers wouldn’t let me.
Apparently we For Dummies authors have to follow some rules, and using
“Dummies” and “Mac OS X Tiger” in this book’s title are among them.

And speaking of “dummies,” remember that it’s just a word. I don’t think
you’re dumb — quite the opposite! My second choice for this book’s title was
Mac OS X Tiger For People Smart Enough to Know They Need Help with It, but
you can just imagine what Wiley thought of that. (“C’'mon, that’s the whole
point of the name!” they insisted. “Besides, it’s shorter this way.”)
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Anyway, the book is chock-full of information and advice, explaining every-
thing you need to know about Mac OS X in language you can understand —
along with timesaving tips, tricks, techniques, and step-by-step instructions,
all served up in generous quantities.

What You Won’t Find in this Book

Another rule we For Dummies authors must follow is that our book cannot
exceed a certain number of pages. (Brevity is the soul of wit, and all that.) So
there are some things [ wish I could have included, but they didn’t fit.
Although I feel confident you'll find everything you need to know about Mac
OS X Tiger in this book, some things bear further looking into, including
these:

v+ Information about many of the applications (programs) that come
with Mac OS X Tiger

An installation of Mac OS X Tiger includes more than 50 separate appli-
cations, mostly found in the Applications folder and the Utilities folder
within it. I'd love to walk you through each one of them, but that would
have required a book a whole lot bigger, heavier, and more expensive
than this one.

This book is, first and foremost, about using Mac OS X, so I brief you on
the small handful of bundled applications essential to using Mac OS X
Tiger and keep the focus there. Reserved for independent study else-
where are the iLife application suite (iTunes, iMovie, iPhoto, iDVD, and
GarageBand), as well as other programs that aren’t essential to OS X
(such as Stickies, TextEdit, Chess, DigitalColorMeter, and the like).
Programs you need to know about to configure or use Mac OS X Tiger
(for example, System Preferences, Printer Setup Utility, Activity Monitor
and such) are covered in full and loving detail.

For what it’s worth, there are many books about the applications
included with Mac OS X Tiger; the two my publisher suggested | recom-
mend are Mac OS X Tiger All-in-One Desk Reference, written by Mark L.
Chambers, and iLife 04 All-in-One Desk Reference, written by Tony Bove
and Cheryl Rhodes, which are both (sheer coincidence) published
by Wiley.

v+~ Information about Microsoft Office, AppleWorks, Photoshop, Quicken,
and most other third-party applications

Okay, if all the gory details of all the bundled (read: free) Mac OS X Tiger
applications don’t fit here, I think you’ll understand why digging into
third-party applications that cost extra was out of the question.
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v+ Information about programming for the Mac

This book is about using Mac OS X Tiger, not writing code for it. There
are dozens of books about programming on the Mac, most of which are
two or three times the size of this book.

1 My world-famous Mojito recipe

[ make perhaps the finest Mojito you'll ever find outside of Cuba, but my
editor insists it would be inappropriate to include it in this book (food
stains would make the text hard to read). So if you like a good Mojito,
send me an e-mail at MojitoExpert@doctormacdirect.comandI'll
send you a Mojito recipe that will knock your socks off. (If you don’t
know what a Mojito is, here’s a chance to find out.)

Conventions Used in This Book

To get the most out of this book, you need to know how I do things and why.
Here are a few conventions used in this book to make your life easier:

v When | want you to open an item in a menu, [ write something like
“Choose Filem>Open,” which means, “Pull down the File menu and
choose the Open command.”

v~ Stuff you're supposed to type appears in bold type, like this.

+* Sometimes an entire a sentence is in bold, as you’ll see when I present
a numbered list of steps. In those cases, I debold what you’re supposed
to type, like this.

v Web addresses, programming code (not much in this book), and things
that appear onscreen are shown in a special monofont typeface, 11ke
this.

1 When I refer to the % menu, I'm referring to the menu in the upper-left
corner of the Finder menu bar that looks like a blue or graphite Apple
(called the Apple menu). For example, I may say, “From the ® menu,
choose File=>Open.” I do not use the % symbol to refer to the key on
your Mac keyboard that may or may not have both the 3 and & sym-
bols on it. I refer to that key (called the Command key) with the equally
funky 8 symbol and write something like, “Press the 8 key.” So, when
you see 8, think Apple menu.

v For keyboard shortcuts, I write something like 8+A, which means to
hold down the $ key (the one with the little pretzel and/or ® symbol on
it) and then press the letter A on the keyboard. If you see something like
38 +Shift+A, that means to hold down the 8 and Shift keys while pressing
the A key. Again, for absolute clarity, [ never refer to the 38 key with the
®& symbol. I reserve that symbol for the ® menu (Apple menu). For the
Command key, | use only the 38 symbol. Got it? Very cool.
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What You're Not to Read

The first few chapters of this book are where [ describe the basic everyday
things that you need to understand in order to operate your Mac effectively.

Even though Mac OS X Tiger is way different from previous Mac operating
systems, this first part is so basic that if you've been using a Mac for long,
you may think you know it all — and you may know most of it. But hey! —
not-so-old-timers need a solid foundation. So here’s my advice: Skip through
the stuff you know; you’ll get to the better stuff faster.

Other stuff that you can skip over (if you're so inclined) is any sidebar or sec-
tion marked with a Technical Stuff icon, which I talk about in a moment.

Foolish Assumptions

Although I know what happens when you make assumptions, I've made a few
anyway. First, [ assume that you, gentle reader, know nothing about using
Mac OS X — beyond knowing what a Mac is, that you want to use OS X, that
you want to understand OS X without digesting an incomprehensible techni-
cal manual, and that you made the right choice by selecting this particular
book.

And so, I do my best to explain each new concept in full and loving detail.
Maybe that’s foolish, but . . . oh well.

Oh, and I also assume that you can read. If you can’t, ignore this paragraph.

How This Book Is Organized

Mac OS X Tiger For Dummies is divided into five logical parts, numbered (sur-
prisingly enough) 1 through 5. By no fault of mine, they’re numbered using
those stuffy old Roman numerals, so you'll see I-V where you (in my humble
opinion) ought to see Arabic numbers 1-5. Another rule, I think.

Anyway, it’s better if you read the parts in order, but if you already know a
lot — or think you know a lot — feel free to skip around and read the parts
that interest you most.



Introduction

Part I: Introducing Mac 0S X

This first part is very, very basic training. From the mouse to the Desktop,
from menus, windows, and icons to the snazzy-but-helpful Dock, it’s all here.
A lot of what you need to know to navigate the depths of Mac OS X safely and
sanely will be found in this section. And although old-timers may just want to
skim through it, you newcomers should probably read every word. Twice.

Part II: Rounding Out Your Basic Training

In this part, I build on the basics of Part I and really get you revving with your
Mac. Here I cover additional topics that every Mac user needs to know, cou-
pled with some hands-on, step-by-step instruction. It starts with a closer look
at the program you’ll be using most, the OS X Finder, followed by a chapter
about how to open and save files (a skill you're sure to find handy). Next
comes a chapter about managing your files for maximum efficiency followed
by a quick look at using removable media (which means ejectable disks —
CDs, DVDs, and even oldies but goodies such as Zip drives). Last, but cer-
tainly not least, is a chapter about the importance of backing up your data —
and how to do it painlessly.

Part I1I: Doing Stuff with Your Mac

This part is chock-full of ways to do cool stuff with your Mac. In this section,
you’'ll discover the Internet first — how to get it working on your Mac, and
what to do with it after you do. Next, I show you the ins and outs of printing
under OS X. You also read about some of the more important OS X-related
applications and features, plus how to make your Tiger look and feel just the
way you like it. That’s all followed by the lowdown on the Classic Environment,
and possibly the most useful chapter in the whole book, Chapter 13, which
details each and every gosh-darned System Preference, filled with useful obser-
vations and recommendations.

Part IV: Networking and Troubleshooting

Here I get into the nitty-gritty underbelly of Mac OS X, where I cover some-
what more advanced topics, such as file sharing, creating and using multiple
users (and why you might want to), and the all-important troubleshooting
chapter, Chapter 15.

5
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Part U: The Part of Tens

Finally, it’s The Part of Tens, which may have started life as a Letterman rip-
off, although it does include heaping helpings of tips, optional software, great
Mac Web sites, and hardware ideas.

The Appendix

Last, but certainly not least, I cover installing Mac OS X Tiger in the Appendix.
The whole process has become quite easy with this version of the system soft-
ware, but if you have to install Tiger yourself, it would behoove you to read
this helpful Appendix first.

Icons Used in This Book

\\J

You'll see little round pictures (icons) off to the left side of the text through-
out this book. Consider these icons as miniature road signs, telling you a little
something extra about the topic at hand. Here’s what the different icons look
like and what they all mean.

Look for Tip icons to find the juiciest morsels: shortcuts, tips, and undocu-
mented secrets about Tiger. Try them all; impress your friends!

When you see this icon, it means that this particular morsel is something that
[ think you should memorize (or at least write on your shirt cuff).

Put on your propeller-beanie hat and pocket protector; these parts include
the truly geeky stuff. It’s certainly not required reading, but it must be inter-
esting or informative or [ wouldn’t have wasted your time with it.

Read these notes very, very, very carefully. (Did I say very?) Warning icons
flag important information. The author and publisher won’t be responsible if
your Mac explodes or spews flaming parts because you ignored a Warning
icon. Just kidding. Macs don’t explode or spew (with the exception of a few
choice PowerBook 5300s, which won’t run Tiger anyway). But I got your
attention, didn’t I? I'll tell you once again: It is a good idea to read the
Warning notes very carefully.
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These icons represent my ranting or raving about something that just bugs
me. Imagine foam coming from my mouth. Rants are required to be irreverent,
irrelevant, or both. I try to keep them short, more for your sake than mine.

Well, now, what could this icon possibly be about? Named by famous editor-
ial consultant Mr. Obvious, this icon highlights all things new and different in
Mac OS X Tiger.

Where to Go from Here

\\J

Go to a comfortable spot (preferably not far from a Mac) and read the book.

[ didn’t write this book for myself. [ wrote it for you and would love to hear
how it worked for you. So please drop me a line or register your comments
through the Wiley Online Registration Form located at www.dummies.com.

You can send snail mail care of Wiley, Inc. (the mailroom there will see that I
receive it), or if you want me to see it sometime in this century, you might
want to send e-mail to me directly at

Tigerfordummies@doctormacdirect.com

Did this book work for you? What did you like? What didn’t you like? What
questions were unanswered? Did you want to know more about something?
Did you want to find out less about something? Tell me! [ have received more
than 100 suggestions about previous editions, most of which are incorpo-
rated here. So keep up the good work!

[ appreciate your feedback, and I fry to respond to all reasonably polite e-mail
within a few days.

So what are you waiting for? Go — enjoy the book!

/
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In this part . . .

M ac OS X Tiger sports tons of new goodies and fea-
tures. I'll get to the hot new goodies soon enough,

but the standard approach is crawl first, we walk later.

In this part, you discover the most basic of basics, such as
how to turn on your Mac. Next, | acquaint you with the Mac
OS X Desktop: windows, icons, menus, and the Dock — you
know, the whole shmear. To finish things up, I describe
each and every OS X menu in full and loving detail. (Yum.)

So get comfortable, roll up your sleeves, fire up your Mac
if you like, and settle down with Part I, a delightful little
section I like to think of as “The Hassle-Free Way to Get
Started with Mac OS X Tiger.”




Chapter 1

Mac 0S X Tiger 101
(Prerequisites: None)

In This Chapter
Defining Mac OS X Tiger
Finding help if you're a beginner
Turning on your Mac
Shutting down your Mac without getting chewed out by it
Knowing what you should see when you turn on your Mac
Taking a refresher course on using a mouse
Touring the Desktop
Sniffing out the default Desktop icons
Beautifying your Desktop

C ongratulate yourself on choosing Mac OS X, which stands for Macintosh
Operating System X — that’s the Roman numeral ten, not the letter X
(pronounced ten, not ex). You made a smart move because you scored more
than just an operating system upgrade. Mac OS X version 10.4 Tiger includes
dozens of new or improved features to make using your Mac easier as well as
dozens more that help you do more work in less time. Now you can use these
new features to be more productive, have fewer headaches, reduce your cho-
lesterol level, and fall in love with your Mac all over again.

In this chapter, I start at the very beginning and talk about Mac OS X in
mostly abstract terms. After the basics are out of the way, I get right down to
the real nitty-gritty about the Mac OS X Desktop — the place where you start
doing stuff with your Mac.

Those of you who’ve been using Mac OS X for a while may find some of the
information in this chapter hauntingly familiar; some features that I describe
haven’t changed from earlier versions of Mac OS X.

Besides, if you decide to skip this chapter — just because you think you have
all the new stuff figured out — I assure you that you’ll miss out on sarcasm,
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clever wordplay, shortcuts, awesome techniques, a bad pun or two, and
some good advice on making the Desktop an easier place to be. If that’s not
enough to convince you, I also provide a bunch of stuff that Apple didn’t
bother to tell you (as if you read every word in Mac OS X Help, which is the
only user manual Apple provides anyway!).

P Those of you who are about to upgrade to Mac OS X Tiger from an earlier ver-
sion of Mac OS — in particular, Mac OS 9 or a previous Mac OS X release such
as Panther or Jaguar — should read the Appendix right about now. It con-
tains important information about installing Tiger that can make upgrading a
more pleasant experience.

QNING/ If you are about to upgrade to Tiger, I feel obliged to mention a major pitfall
to avoid: One very specific misplaced click in the wrong place, done while
installing your new OS, could erase every file on your hard drive. The
Appendix describes it. So if you aren’t running Tiger yet, I urge you to read
the Appendix before you install — it could save your bacon.

To sum things up: This chapter contains some important information that
you need to know in order to use Mac OS X Tiger successfully. If you're a total
beginner to the Mac experience, you should probably read every word in this
chapter. Even if you're past the beginner stage, you may want to skim these
sections anyway to refresh your memory.

Tantalized? Let’s rock.

Gnawing to the Core of 0S X

Along with the code in its read-only memory (ROM), the operating system
(that is, the OS in Mac OS X) is what makes a Mac a Mac. Without it, your Mac
is a pile of silicon and circuits — no smarter than a toaster.

“So what does an operating system do?” you ask. Good question. The short
answer is that an operating system controls the basic and most important
functions of your computer. In the case of Mac OS X and your Mac, the oper-
ating system

v Manages memory.

v Controls how windows, icons, and menus work.

v Keeps track of files.

1 Manages networking.

v Does housekeeping. (No kidding!)

Other forms of software, such as word processors and Web browsers, rely on
the operating system to create and maintain the environment in which that
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software works its magic. When you create a memo, for example, the word
processor provides the tools for you to type and format the information. In
the background, the operating system is the muscle for the word processor,
performing crucial functions such as the following:

v Providing the mechanism for drawing and moving the on-screen window
in which you write the memo

v Keeping track of a file when you save it

\\3

v Helping the word processor create drop-down menus and dialogs for

you to interact with

v Communicating with other programs

v And much, much more (stuff that only geeks could care about)

So, armed with a little background in operating systems, take a gander at the

next section before you do anything else with your Mac.

Don’t let that UNIX stuff scare you. It’s there if you want it, but if you don’t

want it or don’t care (like most of us), you'll rarely even know it’s there. All
you’ll know is that your Mac just runs and runs and runs without crashing

and crashing and crashing.

One last thing: As [ mention in the Introduction (I'm only repeating it for

those of you who don’t read Introductions), Mac OS X Tiger comes with more

than 50 applications. And although I'd love to tell you all about each and

every one, [ can only tell you about the small handful of bundled applications

The Mac advantage

Most of the world’s PCs use Windows. You're
among the lucky few to have a computer with
an operating system that's intuitive, easy to use,
and (dare | say) fun. If you don't believe me, try
using Windows for a day or two. Go ahead. You
probably won't suffer any permanent damage.
In fact, you'll really begin to appreciate how
good you have it. Feel free to hug your Mac. Or
give it a peck on the CD-ROM drive slot — just
try not to get your tongue caught.

As someone once told me, “Claiming that the
Macintosh is inferior to Windows because
most people use Windows is like saying that all
other restaurants serve food that's inferior to
McDonald’s.”

We may be a minority, but we have the best,
most stable, most modern all-purpose operating
system in the world, and here’s why: UNIX—on
which Mac 0S X is based — is widely regarded
as the best industrial-strength operating system.
For now, just know that being based on UNIX
means that a Mac running OS X will crash less
often than an older Mac or a Windows machine,
which means less downtime. But perhaps the
biggest advantage OS X has is that when an
application crashes, it doesn't crash your entire
computer, and you don't have to restart the thing
to continue working.

13
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essential to using Mac OS X Tiger. If you need more info on the programs I
don’t cover, may I (again) recommend Mac OS X Tiger All-in-One Desk
Reference For Dummies, written by Mark L. Chambers, or iLife ‘04 All-in-One
Desk Reference For Dummies, written by my old friends Tony Bove and Cheryl
Rhodes (both from Wiley).

A Safety Net for the Absolute
Beginner (Or Any User)

In this section, I deal with the stuff that the manual that came with your Mac
doesn’t cover — or doesn’t cover in nearly enough detail. If you're a first-time
Macintosh user, please, please read this section of the book carefully — it
could save your life. Okay, okay, perhaps I'm being overly dramatic. What I
mean to say is that reading this section could save your Mac. Even if you're
an experienced Mac user, you may want to read this section anyway. Chances
are you’ll see at least a few things you may have forgotten (and that may
come in handy).

Turning the dang thing on

Okay. This is the big moment — turning on your Mac! Gaze at it longingly first
and say something cheesy, such as “You're the most awesome computer I've
ever known.” If that doesn’t turn on your Mac (and it probably won’t), keep
reading.

Apple, in its infinite wisdom, has manufactured Macs with power switches
and buttons on every conceivable surface: on the front, side, and back of the
computer itself, and even on the keyboard or monitor. So if you don’t know
how to turn on your Mac, don’t feel bad — just look in the manual or booklet
that came with your Mac.

Some Macs (including most older PowerBooks) even hide the power button
behind a little plastic door. Because of the vast number of different configura-
tions, I can’t tell you where the switch is without devoting a whole chapter
just to that topic. (Can you say b-0-o-r-r-ring?)

These days some Macs have a power-on button on the keyboard; if so, it usu-
ally looks like the little circle thingie you see in the margin.

Don’t bother choosing Help=>Mac Help, which opens the Help Viewer pro-
gram because it can’t tell you where the switch is either. Although the Help
program is good for learning a lot of things, the location of the power switch
isn’t among them. Of course, if you haven’t found the switch and turned on
the Mac, you can’t access Help anyway. (D’oh!)
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What you should see on startup

When you finally do turn on your Macintosh, you set in motion a sophisticated
and complex series of events that culminates in the loading of Mac OS X and
the appearance of the Mac OS X Desktop. After a small bit of whirring, buzzing,
and flashing (meaning that the operating system is loading), OS X first tests all
your hardware — slots, ports, disks, random-access memory (RAM) — and so
on. If everything passes, you hear a pleasing musical tone and see the tasteful
gray Apple logo in the middle of your screen, along with a small spinning-
pinwheel cursor somewhere on the screen. Both are shown in Figure 1-1.
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-
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v~ Everything is fine and dandy: Next, you see the soothing graphite Apple
logo, the words Mac OS X, and a status indicator with messages that tell
you the Mac is going through its normal startup motions. Makes you feel
kind of warm and fuzzy, doesn’t it? If all this fanfare shows up on-screen,
Mac OS X is loading properly. In the unlikely event that you don’t see the
gray Apple logo, the soothing messages, and/or the familiar Desktop, see
Chapter 15 (where I show you how to troubleshoot your system).

Next, you may or may not see the Mac OS X login screen, where you
enter your name and password. If you do, press the Enter or Return key
(after you type your name and password, of course) and away you go.

If you don’t want to have to type your name and password every time
you start or restart your Mac (or even if you do), check out Chapter 13
for the scoop on how to turn the login screen on or off.

Either way, the Desktop soon materializes before your eyes. If you
haven’t customized, configured, or tinkered with your Desktop, it should
look something like Figure 1-2. Now is a good time to take a moment for
positive thoughts about the person who convinced you that you wanted
a Mac. That person was right!

15
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v Sad Mac: If any of your hardware fails when it’s tested, you could see a
black or gray screen that may or may not display the dreaded Sad Mac
icon (shown in the left margin) and/or hear a far less pleasing musical
chord (in the key of F-minor, I believe), known by Mac aficionados as the
Chimes of Doom.

Some older Macs played the sound of a horrible car wreck instead of the
chimes, complete with crying tires and busting glass. It was exception-
ally unnerving, which may be why Apple doesn’t use it anymore.

é‘g\l\BER The fact that something went wrong is no reflection on your prowess as
& a Macintosh user. Something inside your Mac is broken, and it probably
needs to go in for repairs (usually to an Apple dealer). If any of that’s
already happened to you, check out Chapter 16 to try to get your Mac
well again.

P If your computer is under warranty, dial 1-800-SOS-APPL, and a customer-
service person can tell you what to do. Before you do anything, though,
skip ahead to Chapter 15. It’s entirely possible that one of the sugges-
tions there can get you back on track without you having to spend even
a moment on hold.

 Prohibitory sign (formerly known as the flashing-question-mark disk):
® Although it’s unlikely that you’ll ever see the sad Mac, most users even-
tually encounter the prohibitory sign shown in the left margin (which
replaced the flashing question-mark-on-a-disk icon and flashing folder
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icon back in OS X 10.2 Jaguar). This icon means your Mac can’t find a
startup disk, hard drive, network server, or CD-ROM containing a valid
Macintosh operating system. See Chapter 15 for ways you can try to
ease your Mac’s ills.

P How do you know which version of the’MaC OS your computer has? Simpl’e.
Just choose About This Mac from the ® menu (that’s the menu with the ®
symbol in the upper-left corner of the Finder menu bar). The About This Mac
window pops up on your screen, as shown in Figure 1-3. The version you're
running appears just below Mac OS X in the center of the window. Click the
More Info button to launch the System Profiler application, which has much
more information, including processor speed, bus speed, number of proces-
sors, caches, installed memory, networking, storage devices, and much more.

You can find more about this useful program in Chapter 11.

(&) About This Mac
.

( ]

Mac OS X
Version 10.4
Figure 1-3: ( Software Update... )
See WhICh Processor 800 MHz PowerPC G4
version of § i::’m“
Mac 0S X e
you're ( moremnfo.. )
running. M & © Apple
|

Bootthis. Bootthat. “| booted my Mac and....”
or “Did it boot?” and so on. Talking about com-
puters for long without hearing the bootword is
nearly impossible.

But why boot? Why not shoe or shirt or even
shazam?

Back in the very olden days — maybe the 1960s
or a little earlier — starting up a computer
required you to toggle little manual switches on
the front panel, which began an internal
process that loaded the operating system. The
process became known as bootstrapping
because if you toggled the right switches, the

The legend of the boot

computer would “pull itself up by its boot-
straps.” This phrase didn't take long to trans-
mogrify into booting and finally to boot.

Over the years, booting has come to mean turn-
ing on almost any computer or even a periph-
eral device, such as a printer. Some people also
use it to refer to launching an application: “|
booted Excel.”

So the next time one of your gearhead friends
says the b-word, ask whether he knows where
the term comes from. Then dazzle him with the
depth and breadth of your (not-quite-useful)
knowledge!
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Shutting down properly

Turning off the power without shutting down your Mac properly is one of the
worst things you can do to your poor Mac. Shutting down your Mac improp-
erly can really screw up your hard drive, scramble the contents of your most
important files, or both.

If a thunderstorm is rumbling nearby or if you're unfortunate enough to have
rolling blackouts where you live, you may really want to shut down your Mac.
(See the next section where I briefly discuss lightning and your Mac.)

To turn off your Mac, always use the Shut Down command on the ® menu
(which I discuss in Chapter 3), or you can shut down in one of these kind-
and-gentle ways:

v Press the Power key once and then click the Shut Down button.

v On Apple Pro keyboards, which don’t have a Power key, press
Control+Eject instead, and then click the Shut Down button that appears
(or press the Return key, which does the same thing).

Of course, most of us have broken this rule several times without anything
horrible happening — but don’t be lulled into a false sense of security. Break
the rules one time too many (or under the wrong circumstances), and your
most important file will be toast. The only times you should turn off your Mac
without shutting down properly is if your screen is frozen or if you crash and
you've already tried everything else. (See Chapter 15 for what those “every-
thing elses” are.) A really stubborn crash doesn’t happen often — and less
often under OS X than ever before — but when it does, turning your Mac off

Eternally yours . .. now

Mac 0S X is designed so you never have to shut
it down. You can configure itto sleep after a spec-
ified period of inactivity. (See Chapter 13 for more
info on the Energy Saver features of 0S X.) If you
do so, your Mac will consume very little electric-
ity when it's sleeping and will be ready to use just
a few seconds after you awaken it (by pressing
any key or clicking the mouse). On the other hand,
if you're not going to be using it for a few days,
you may want to shut it down anyway.

Note: If you leave your Mac on constantly and
you're gone when a lightning storm or rolling

blackout hits, your Mac may get wasted. So be
sure you have adequate protection (say, a decent
surge protector designed specifically for com-
puters) if you decide to leave your Mac on and
unattended for long periods. See the section “A
few things you should definitely NOT do with your
Mac"” (elsewhere in this chapter) for more info on
lightning and your Mac. Frankly, if | plan to be
away from mine for more than a day, | usually
shut it down, just in case. But because 0S X is
designed to run 24/7, | don't shut it down at night
unless it's dark and stormy.
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and then back on may be the only solution. Sometimes even that doesn’t
work, and you may have to unplug the computer from the power outlet, wait
a moment or two, and then plug it back in to get it to reboot.

A few things you should definitely
NOT do with your Mac

In this section, I deal with the bad stuff that can happen to your computer if you
do the wrong things with it. If something bad has already happened to you —
I know . .. I'm beginning to sound like a broken record — see Chapter 15.

+ Don’t unplug your Mac when it’s turned on. Very bad things can
happen, such as having your operating system break. See the preceding
section, where I discuss shutting your system down properly.

v Don’t use your Mac when lightning is near. Here’s a simple life equa-
tion for you: Mac + lightning = dead Mac. 'Nuff said. Oh, and don’t place
much faith in inexpensive surge protectors. A good jolt of lightning will
fry the surge protector right along with your computer — as well as pos-
sibly frying your modem, printer, and anything else plugged into it. Some
surge protectors can withstand most lightning strikes, but these war-
riors aren’t the cheapies that you buy at your local computer emporium.
Unplugging your Mac from the wall during electrical storms is safer and
less expensive. (Don’t forget to unplug your external modem, network
hubs, printers, or other hardware that plugs into the wall as well — light-
ning can fry them, too.)

+* Don’t jostle, bump, shake, kick, throw, dribble, or punt your Mac,
especially while it’s running. Your Mac contains a hard drive that spins
at 4,200+ revolutions per minute (rpm) or more. A jolt to a hard drive
while it’s reading or writing a file can cause the head to crash into the
disk, which can render many (or all) files on it unrecoverable. Ouch!

+* Don’t forget to back up your data! I beg you: Please read Chapter 8 now
before something horrible happens to your valuable data! If the stuff on
your hard drive means anything to you, you must back it up. Not maybe.
You must. Even if your most important file is your last saved game of
Tony Hawk Pro Skater 2, you still need to realize how important it is to
back up your files.

In Chapter 8, I discuss how to back up your files, and I strongly recom-
mend that you read Chapter 8 sooner rather than later — preferably
before you do any significant work on your Mac. Dr. Macintosh sez:
“There are only two kinds of Mac users: Those who have never lost data
and those who will.” Which kind will you be?

v Don’t kiss your monitor while wearing stuff on your lips. For obvious
reasons! Use a soft cloth and/or the Klear Screen polish and wipes that
Apple recommends if you need to clean your display.

19
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Point-and-click boot camp

Are you new to the Mac? Just learning how to move the mouse around? Now
is a good time to go over some fundamental stuff that you need to know for
just about everything you’ll be doing on the Mac. Spend a few minutes read-
ing this section, and soon you’ll be clicking, double-clicking, pressing, and
pointing all over the place. If you think you've got the whole mousing thing
pretty much figured out, feel free to skip this section. I'll catch you on the
other side.

Still with me? Good. Now for some basic terminology.

v Point: Before you can click or press anything, you have to point to it.
Place your hand on your mouse and move it so that the cursor arrow is
over the object you want — like on top of an icon or a button. Then click
the mouse to select the object or double-click it to run it (if it’s an appli-
cation or an icon that starts up an application). You point and then you
click — point-and-click, in computer lingo.

v Click: (Also called single-click.) Use your index finger to push the mouse
button all the way down and then let go so it produces a satisfying click-
ing sound. (If you have one of the new optical Apple Pro mice, you push
down the whole thing to click.) Use a single-click to highlight an icon,
press a button, or activate a check box or window.

v Double-click: Click twice in rapid succession. With a little practice, you
can perfect this technique in no time. Use a double-click to open a folder
or to launch a file or application.

v+ Control-click: Hold down the Control key while single-clicking. Control-
clicking is the same as right-clicking on a Windows system and dis-
plays a menu (called a contextual menu) where you Control-clicked. In
fact, if you are blessed with a two-or-more-button mouse (I personally
use the four-button Kensington Expert Mouse Pro Trackball, and rec-
ommend it highly), you can right-click and avoid having to hold down
the Control key.

v Drag: Dragging something usually means you have to click it first and
hold the mouse button down. Then you move the mouse on your desk
or mouse pad so the cursor — and whatever you select — moves across
the screen. The combination of holding down the button and dragging
the mouse it is usually referred to as click-and-drag.

v Press: A press is half a click. Instead of letting go of the mouse button to
finish the click, keep holding it down. In most cases, your next step is to
drag the mouse somewhere — say, down a menu to choose a command,
or across the screen to move an object.

v Choosing an item from a menu: To get to Mac OS menu commands, you
must first open a menu and then pick the option you want. Point at the
name of the menu you want with your mouse cursor, press your mouse
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button down, and then drag your mouse downward until you select the
command you want. When the command is highlighted, finish selecting
by letting go of the mouse button.

If you're a long-time Mac user, you probably hold down the mouse button the
whole time between clicking the name of the menu and selecting the com-
mand you want. You can still do it that way, but you can also click once on
the menu name to open it, release the mouse button, and then drag down to
the item you want to select and then click again. In other words, OS X menus
stay open for a few seconds after you click them, even if you're not holding
down the mouse button. Go ahead and give it a try . . . I'll wait.

Touring the Desktop
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Just about everything you do on your Mac begins and ends with the Desktop.
This is where you manage files, store documents, launch programs, adjust
the way your Mac works, and much more. If you ever expect to master your
Mac, the first step is to master the Desktop.

Some folks use the terms Desktop and Finder interchangeably to refer to the
total Macintosh environment you see — icons, windows, menus, and all that
other cool stuff. Just to make things confusing, the background you see on
your screen — the backdrop behind your hard drive icon and open windows —
is also called the Desktop. In this book, I refer to the Finder as the Finder, which
I discuss in Chapters 4 and 5. When I say Desktop, I'm talking about the back-
ground behind your windows and Dock.

Got it? The Desktop is convenient and fast. Put stuff there.
Check out the default Mac Desktop for OS X in Figure 1-4.

The Desktop is the center of your Mac OS experience, so before I go any far-
ther, here’s a quick description of its most prominent features:

v Desktop: The Desktop is the area behind the windows and the Dock,
where your hard drive icon (ordinarily) lives. The Desktop isn’t a window,
yet it acts like one. Like a folder window or drive window, the Desktop can
contain icons. But unlike most windows, which require a bit of navigation
to get to, the Desktop is a great place for things you use a lot, such as fold-
ers, applications, or particular documents. The next section discusses the
default icons you see on the Desktop when you first load up OS X.

v Dock: The Dock is the Finder’s main navigation shortcut tool. It makes
getting to frequently used icons easy, even when you have a screen full
of windows. Like the Desktop, the Dock is a great place for things you
use a lot, such as folders, applications, or particular documents. Besides
putting your frequently used icons at your fingertips, it’s almost infi-
nitely customizable, too; read more about it in Chapter 2.
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P If you used an earlier version of Mac OS, think of the Dock as the OS X

version of the Apple menu in Mac OS versions of the past. Yes, the OS X
Finder does have an Apple menu, but it doesn’t work at all like the Apple

menu in earlier versions of Mac OS. See Chapter 3 for more info on the
Apple menu.

v Icons: Icons are the little pictures you see in your windows and even on
your Desktop. Most icons are containers that hold things you work with
on your Mac, such as programs and documents, which are also repre-
sented by — you guessed it — icons. In Chapter 2, | cover icons in detail,
and the next section discusses the icons you see on the OS X Desktop
when you first boot up your Mac.

v~ Aliases: Use aliases of things that you use often so you can keep the

originals tucked away in one of your perfectly organized folders. Check
out aliases in Chapter 2.

1+ Windows: Opening most icons (by double-clicking them) makes a
window appear. Windows in the Finder show you the contents of hard
drive and folder icons, and windows in applications usually show you
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the contents of your documents. For the full scoop on Tiger windows,
which are very different from Mac windows in previous OS releases,
check out Chapter 3.

v Menus: Menus let you choose to do things, such as create new folders;
duplicate files; cut, copy, or paste text; and so on. Find out all about

them in Chapter 3.
\\J

If all these new terms such as alias, Dock, and so on seem strange to
you, don’t worry — I explain them all in detail in the rest of Part 1.

Sniffing Out the Default Desktop lcons

Icons on the Desktop behave the same as icons in a window. You move them
and copy them just like you would an icon in a window. The only difference is
that Desktop items aren’t in a window: They’re on the Desktop, which makes
them more convenient to use.

Actually, if you look at your Home directory (click the Home button on any
Finder window toolbar or use the shortcut 8+Shift+H to open a window dis-
playing Home), you see a folder named Desktop, which contains the same
icons you place on the Desktop (but not the hard-drive icons). The reason for
this folder is that each user has an individual Desktop. But I'm getting ahead
of myself. You find out much more about Home, users, and all that jazz in
upcoming chapters.

P To move an item to the Desktop, simply click its icon in any window and
then, without releasing the mouse button, drag it out of the window and onto
the Desktop; then release the mouse button. If you don’t see a disk icon on
your Desktop, skip ahead to Chapter 3, where I discuss Finder Preferences.
That’s where you can choose whether to see disks on your Desktop.

v Hard drive icons: The first icon you should get to know is the icon for
your hard drive (refer to Figure 1-4). You can usually find it on the upper-
right side of the desktop when you first start the Mac. Look for the name
Macintosh HD, iMac HD, or something like that, unless you've already
renamed it. (I renamed my hard drive TigerDisk in Figure 1-5.)

There are two ways to rename your hard drive:

¢ Single-click the icon’s name. When the name highlights (as
shown in the middle icon in Figure 1-5), type its new name.

\3
) If you click directly on the icon instead of its name, the icon will be

selected but the name won’t become highlighted for editing, as shown in
the icon on the right in Figure 1-5.

or

¢ Single-click the icon itself, press Return or Enter, and then type
in a new name for the drive.
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Figure 1-5:
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v~ Disk icons: These appear on the Desktop by default. When you insert a
CD or DVD, its icon appears on the Desktop just below your hard-drive
icon (space permitting).

Picture This: A Picture on Your Desktop

I'd be remiss if I didn’t mention that you can change the background picture
of your Desktop.

In Figure 1-6, you can see my Desktop with a background picture I made to
celebrate the release of the book before this one, GarageBand For Dummies
(Wiley). If you want a reminder of what the default Desktop background looks
like, refer to Figure 1-4.

Here’s how you can change your Desktop picture if you care to:
1. From the Desktop, choose ®>System Preferences or click the System
Preferences icon in the Dock.
The System Preferences window appears.
2. Click the Desktop & Screen Saver icon.

The Desktop & Screen Saver Preferences pane appears as shown in
Figure 1-7.

3. Click on any picture in your Home/Pictures folder.

I'm clicking a picture called drmacandbandtxt in Figure 1-7. You can see
it’s one of the items in my Home/Pictures folder, which is also shown in
Figure 1-7.



